<table>
<thead>
<tr>
<th>Publish Date</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>9-19-2012</td>
<td>Initial version</td>
</tr>
<tr>
<td>1-31-2013</td>
<td>Updated to reflect code changes in 2.2 and new features: role definitions, permission groups, topology editor, translator update across CAMs and resources</td>
</tr>
<tr>
<td>2-28-2013</td>
<td>Added more detail to the Editor interface, start/stop of translator</td>
</tr>
<tr>
<td>3-31-2013</td>
<td>Added resource group support, updated resource console interface, permission groups updates, instruction process updates</td>
</tr>
<tr>
<td>5-24-2013</td>
<td>Added system requirements; detailed user specific permission management, including mask/unmask alarms rights; and persisting transport starts/stops over CAM restarts</td>
</tr>
<tr>
<td>5-30-2013</td>
<td>Added security policy</td>
</tr>
<tr>
<td>7-11-2013</td>
<td>Added error of duplicate translator name, topology editor enhancements, data point nodes in topologies, addition of pruning names to services, shared module management, direct access to ticketing system, and rule management enhancements</td>
</tr>
<tr>
<td>7-22-2013</td>
<td>Edited for content</td>
</tr>
<tr>
<td>10-4-2013</td>
<td>Added topology editor enhancements (create topology template, hide node name, map size, place nodes based on coordinates, and port identification), ability to define whether user can modify dashboards, view video in services, improvement to Services area in Admin, assign dashboards on a role level, determine what users can modify dashboards</td>
</tr>
<tr>
<td>1-xx-2014</td>
<td>Updated administrator console to reflect new Rack option; added user permissions related to services; added ability to add service while browsing topology; added SSH client to transport management; added warning when rule takes too long to execute; added polling SNMP over TCP in transports; added topology to topology connections to Editor; added ability to hide topology in Views menu; documented the Add Links option in Topology Editor; error if out of range number entry for instruction.</td>
</tr>
</tbody>
</table>
Introduction.......................................................................................................................... 6
  About This Document ........................................................................................................... 6
  System Overview .................................................................................................................. 6
  Minimum System Requirements ......................................................................................... 7
    Windows............................................................................................................................... 7
    Mac OS .............................................................................................................................. 7
    Linux ................................................................................................................................. 7
  Application Vulnerability and Security Policy ................................................................. 7
NMS Administration ............................................................................................................... 8
  Accessing the Different Areas .............................................................................................. 8
  System Configuration ........................................................................................................... 9
  Troubleshooting .................................................................................................................. 9
Accessing the Administrator Console .................................................................................. 10
Managing NMS Users ......................................................................................................... 12
  Managing Permission Groups ............................................................................................ 12
    Adding a Permission Group ............................................................................................. 13
    Viewing/Editing Permission Groups .............................................................................. 17
  Managing Roles .................................................................................................................. 20
    Adding a Role .................................................................................................................. 20
    Viewing/Editing a Role ................................................................................................. 21
  Managing Users .................................................................................................................. 22
    Adding a User .................................................................................................................. 22
    Modifying a User’s Permissions .................................................................................... 25
      Editing a User ............................................................................................................... 27
      Deleting a User ............................................................................................................. 27
    Disabling/Deleting Inactive Users .................................................................................. 27
CAMs .................................................................................................................................... 28
Managing Transports.......................................................................................................... 30
  Filtering ............................................................................................................................... 31
  Viewing Transport Details ................................................................................................. 31
  Starting/Stopping a Transport ............................................................................................ 32
  Adding a Transport ............................................................................................................. 33
  Editing a Transport ............................................................................................................. 35
  Deleting a Transport .......................................................................................................... 36
Managing Resources ............................................................................................................ 37
  Filtering ............................................................................................................................... 38
  Viewing a Resource’s Details ............................................................................................. 38
  Adding a Resource ............................................................................................................. 41
Applying Rules ......................................................................................................................... 89
Rolling Out Rule Updates Across the System ............................................................................. 89
Warnings ................................................................................................................................... 90

Managing Topologies .................................................................................................................. 91
Editing a Topology ..................................................................................................................... 92
Connecting to Another Topology ............................................................................................... 96
Applying Topology Changes in Bulk (To Multiple Topologies at Once) .................................. 99
Creating a Topology .................................................................................................................. 101
  Adding Data Point Nodes with String Values ......................................................................... 108
  Adding Links ........................................................................................................................... 110
  Diagram Settings .................................................................................................................... 112
  Diagram Layout ..................................................................................................................... 113
  Diagram Layering ................................................................................................................... 113
  Diagram Navigation ................................................................................................................. 114
  Publishing the Topology ......................................................................................................... 114
Creating Templates .................................................................................................................... 114
Importing and Exporting Diagrams ............................................................................................ 117

Opening Tickets ......................................................................................................................... 119
Viewing Logs ............................................................................................................................. 122

Definition of Terms and Acronyms ............................................................................................ 125
Introduction

About This Document

The CodeMettle Network Management System (NMS) includes an Administrator Manual and an Operator Manual. The Operator Manual focuses on the day-to-day monitoring and management of network resources within the NMS interface. The Administrator Manual focuses on system configuration; including setting resource data point values and display rules, viewing NMS logs, and managing NMS users.

The first part of this manual introduces the NMS as a whole. Subsequent chapters explain specific configuration areas. Where applicable, each chapter starts by explaining how the functions relate to the rest of the network, followed by detailed instructions on how to perform each task. A glossary/explanation of terms and acronyms is found at the end of the document.

While both manuals include the System Overview and the Glossary of Terms, the Operator Manual includes instructions on accessing the NMS GUI and system navigation, as well as introduces terms seen throughout the interface, while this manual does not. While operators will probably never need this manual, it is advised that administrators also refer to the Operator Manual to become familiar with the layout and the tools used in daily operations.

System Overview

CodeMettle’s Network Management System (NMS) is built on a modular design, allowing it to scale to very large networks by simply replicating and distributing the software components that comprise the solution across the network according to demand. The modules are connected via a Service Oriented Architecture (SOA) backplane, which is a service-based interface. This means that not just the device’s health is being managed, but the service being provided by the coupled resources and the point of usage is also monitored. The NMS employs a simple data model that adapts to any type of managed entities, resources, and equipment; this allows administrators to group different (or the same) types of resources into a single entity, making the job of day-to-day monitoring and management that much easier.
Minimum System Requirements

Following are the minimum system requirements needed to support the NMS GUI.

Windows

- 2.33GHz or faster x86-compatible processor, or Intel® Atom™ 1.6GHz or faster processor for netbooks
- Microsoft® Windows® XP (32 bit), Windows Server 2008 (32 bit), Windows Vista® (32 bit), Windows 7 (32 bit and 64 bit), or Windows 8 (Classic or Modern)
- Internet Explorer 7.0 or later, Mozilla Firefox 17, Google Chrome, Safari 5.0 or later, or Opera 11
- 512MB of RAM (1GB of RAM recommended for netbooks); 128MB of graphics memory

Mac OS

- Intel Core™ Duo 1.83GHz or faster processor
- Mac OS X v10.6, v10.7, or v10.8
- Safari 5.0 or later, Mozilla Firefox 17, Google Chrome, or Opera 11
- 512MB of RAM; 128MB of graphics memory

Linux

- 2.33GHz or faster x86-compatible processor, or Intel Atom 1.6GHz or faster processor for netbooks
- Red Hat® Enterprise Linux® (RHEL) 5.6 or later (32 bit and 64 bit), openSUSE® 11.3 or later (32 bit and 64 bit), or Ubuntu 10.04 or later (32 bit and 64 bit)
- Mozilla Firefox 17 or Google Chrome
- 512MB of RAM; 128MB of graphics memory

Application Vulnerability and Security Policy

CodeMettle makes every effort to detect and fix any application vulnerabilities as a part of its quality process. CodeMettle’s normal development process includes standard use of unit, integration, and security testing software to catch software issues related to memory management, cross-site scripting vulnerabilities, and invalid user input. By using a continuous integration method of development, CodeMettle insures that bugs are detected and corrected in a timely manner.

Since the application is used in strictly enforced security environments, correcting security vulnerability issues is on the top of the priority list whether the issue is found internally or externally.

CodeMettle’s standard policy is to provide a patch for any discovered issue within 48-hours of reproducing it. These patches are made available to all customers on a yearly maintenance plan and CodeMettle will proactively notify all customers of high-risk vulnerabilities and assist with patching.

In addition to correcting vulnerabilities, CodeMettle will also assist its customer’s with proper configuration of the system to provide the highest security possible.
NMS Administration

This chapter provides a high level overview of the NMS administrator’s role and major functions.

Accessing the Different Areas

A dropdown menu is seen when the user name is clicked in the upper right corner of the window. This menu provides access to the various areas of the NMS that are not part of day-to-day operations. The options seen are:

- Preferences: This is where the user can set the alarm behaviors displays based on severity. This is described in the Preferences chapter.
- Administration: The System Administration area user provides access to users/roles, CAM, resource, system rules, service, and translator management.
- Masked Alarms: This area displays only alarms that have been masked.
- Topology Editor: Administrators can create system topologies within the Editor area of the NMS interface. Topologies created outside of the NMS system can also be imported and viewed.
- Provisioning: This option accesses the area where device/resource and service data can be imported, exported, deleted, and managed.
- Reports: This is a link to the Pentaho reporting application, where custom reports can be added. For more information about NMS reports, please refer to the CodeMettle Reports Manual.
- BI Server: This is a link to the Pentaho reporting application, where custom reports can be added. For more information about NMS reports, please refer to the CodeMettle Reports Manual.
- Open Ticket: This opens the support application where support tickets can be added and viewed directly
- Help: Accesses the system manuals. When one is selected, the guide opens in a new tab in the browser.
- Log Out: Logs the current user out of the NMS and returns the display to the login page.
System Configuration

System configuration includes adding the components that will be monitored; setting up data point navigation and display to ensure the most relevant feedback is immediately seen; setting up the resources that will perform the watched services; and setting up the alarms that will alert the Network Operations Center (NOC) to a condition. System configuration also includes defining the user/operators that will be using the NMS.

The first administrative task, and the one that may be repeated most often, is user management. The next would be resource management. When adding a resource, certain components need to be present to complete the task. That order is:

1. CAM (done by CodeMettle during system setup)
2. Transport
3. Translator
4. Resource

Once the resource is created, administrators have extensive configuration options within the resource console, including data point display choices and alarm levels. The resource console also provides a set of command instructions that can be run against the system immediately. For ease of management, administrators can also organize resources into groups. A resource group is a logical collection of resources that are shown within the NMS UI as one entity. However, alarms or changes within the group are still identified by the specific resource for quick device identification in support situations.

Once the resources have been established, data circuits/services can be created. The ability to manage network activity at the circuit/service level is one of the key differentiators that ensures the NMS will adapt and thrive with the growing use of service-oriented architectures. Viewing multiple resources as a single group and the function performed as a service not only makes the task of monitoring complex networks more efficient, it focuses on what is actually the goal: to keep the system running successfully.

Troubleshooting

A central part of network management is troubleshooting events to see what happened. The NMS provides a system log maintained by the system’s core Correlation and Automation Machine (CAM) module. The last part of this manual describes accessing this log and how to manage a resource’s logging level.
Accessing the Administrator Console

In the NMS dashboard, rest the mouse over the username displayed in the right corner. From the contextual menu, select Administration.

The System Administration area appears.

There are three main areas: User Administration, Server, and System. An icon represents each element within that area; for example, the System area includes Resource, Group, Rule, Services, and Rack.

Selecting an icon opens that area.

The screen below illustrates general navigation within a specific area (such as the User/ Roles area seen here).
The left pane contains either child options/sub-menus for that area, or lists the items defined in this installation as requested. For example, selecting Other Users in the screenshot above will list the defined users in the left pane.

The right pane displays the screen prompted by the current administrator: add, remove, or view/edit an item.
Managing NMS Users

In the System Administration area, select **User/Roles**.

The user administration area is seen. The currently logged in user (username and role) is seen above the area’s options on the left. Three submenu options are listed:

- Other Users: Used to list, add, and remove other NMS users that have been defined
- Roles: Used to list, add, and remove defined roles within the NMS
- Permissions: Used to list, add, and remove the various permissions available within the NMS

The + and – options seen at the bottom are used in the different areas to add or remove a user, role, or permission. In order to activate these options, one of the three user administration areas must be selected. Otherwise, the system does not know what type of object is being added or removed!

User management is based on role definition. Roles are based on permissions. Therefore, user management, in this case, will be from the bottom up: define the permission groups, then the roles, and then users that will have those roles.

Permission groups are assigned to roles, and roles are assigned to users. Therefore, when first setting up the security system, it makes sense to follow that order.

**Managing Permission Groups**

Permission groups are just what they sound like: one or more permissions, based on a class of object: UI, data point, resource, attribute, topology, or instruction; what that class owns; and the specific instances of that set. Permissions are further set by what a user can do with these items.
Adding a Permission Group
With Permission Groups highlighted in the left pane, click the + symbol.

Enter a name for this group. This will represent the group when roles are being defined. Next enter a Description for this group.

Now add permissions. Permissions are defined by the type of object being controlled, the access the user has (read or read-write) and what objects of that type can be accessed (the List).

Click the + symbol beneath the Permission table in the right pane.
Permissions are defined by the following.

- **Class**: Class defines the type of object in the NMS, such as UI permissions, resource, datapoint, attribute, topology, or instruction.
- **Type**: This is the type of permission, such as Read (view only), create (add) write (modify) or remove (delete) the instance.
- **Instance**: Instances are the specific object types in the class. For example, a UI permission class will list all of the objects that are controlled in the UI, such as users, roles, permissions, etc., while a resource class will list the defined resources in the installation.
Of course, the type of permission is also dependent on the class.

Select a Class, Type of permission, and Instance(s) that can be managed. The Instance list includes an All, allowing all instances to be enabled or disabled at once.

As another example, to restrict what services a user can view and manage, a Permission Group can be created with those services selected. Create a new Permission Group named Alterna Services and select the + symbol (as seen to the right).
For the Permission Class, choose Services. In the Instances table, the created system’s services are listed. Select a Permission Type (read, write) and then choose one or more services in the Instances table.

After the selections are made, click Update. The group’s identity page is seen. Now the Permission table reflects the class, permission/access, and instances assigned. (If all instances were created, the * wildcard symbol is seen.)

To add permissions to another class, click the + symbol under the Permission table again and repeat the steps. Permission groups can have several sets of permissions. However, when defining a Permission Group, remember that it will include all of the class definitions added and will be added to the Role as defined here.
Viewing/Editing Permission Groups

Once defined, permission groups are seen in the left pane when the Permission Group arrow is selected.

To view the group’s details, click the arrow next to the Permission Groups label so that it points downward. Select the icon from the Permission Group list that is now seen.

The pre-defined permission groups installed by default are detailed below. These definitions can be modified to meet specific needs or completely new groups can be defined.

Read-only: Provides the user read only permission within the Operator (main) area of the NMS. Users can view system configurations and activities but cannot make any changes. For example, read-only users can view the details of an alarm but cannot acknowledge the instance being dealt with.

Read-write: Allows the user to read and make changes within the Operator (main) area of the NMS. Read-write users can make changes and set status levels within the NMS UI.

Read-Write Resources & Topologies: This extends the user’s abilities within the NMS interface to view and edit topologies and resource; within the Administrator user menu and in the resource console in regards to data point configurations.

Read-only Resources & Topologies: This user’s views are extended beyond the areas of the Read-only and Read-write user into the Resource and Topology views, but does not grant any editing, adding, or deleting permissions.

There are three options.

1. To remove a specific permission from the group, select the entry from the Permission table on the right and click the icon beneath it.

2. Click Update.

The permission entry is immediately removed. (If this was unintended, click Cancel beneath the table and the permission is added back. However, this can only be reversed until the Update option is selected to commit the change.)
2. To add an additional permission, select the + icon. The Class, Type, and Instance tables are seen as described in the previous section. For example, to add the ability to manage Dashboards to the Read-Write Resources & Topologies group, click the + symbol.

Select the GUI Permissions class and grant the view, create, and delete types. Then select the Dashboards instance.
Click **Update** to save the change.

3. To modify an existing class, select the entry from the Permission table and click the modify icon (shown below).

The current settings are seen.

If any changes are made, select **Update**. To dismiss the screen without changes, click **Cancel**.
Managing Roles

Users are defined by their identity/password settings and by their roles. Roles are defined by permission groups. 

*The only way to define a role’s permission is through the permission group. However, a specific user’s permissions can be modified at the user level. This will be examined in the Managing Users section.*

Adding a Role

With the Roles option highlighted in the left pane, select the + symbol (shown to the left).

The Add Role screen is seen (shown below).

![Add Role Screen](image)

Enter the role’s name and description.

Options in the Permission table are actually the Permission Groups just described. Select one or more permissions.

Click **Update** to save the changes. (Click **Cancel** to dismiss the view without saving).

A success message is seen.
Viewing/Editing a Role

Once added, roles are seen in the Roles sub-menu list when the left arrow is selected.

To view a role’s details, select it from the list. The role, as defined at initial creation, is seen.

Add or remove Permission Group as needed by selecting or de-selecting an entry. However, to further define what the role can see and do, create a new Permission Group and assign it to the role.

If custom dashboards have been created, they can be copied to the role’s profile so the role’s users will see the options when loading a dashboard into the interface. Click Copy Dashboard to Role.

Select the Copy Dashboard to Role icon next to the name. The pane closes, the system copies the dashboard, and the selection appears as the role’s Default dashboard. Additional dashboards can be added but the first dashboard selected remains listed as the default.
In addition, the **Manage Role Dashboards** is enabled. This evokes the Manage Dashboards pop up.

The default dashboard setting can be changed or a dashboard removed from the role. Click **Close** to dismiss the pop up.

Click **Update** on the Edit Role page to save any changes. Select **Cancel** to dismiss the window without saving.

**Managing Users**

Select the arrow to the left of the **Other Users** to expand the list and view the list of currently defined users.

Select a user from the list to view his/her details.

As seen by the tabs above the user details, the NMS user has two aspects: the Password (login/identity) and Permission (what the user can or cannot do in the NMS).

**Adding a User**

Select the Other Users option and click the + symbol in the left pane.
An empty user dialog window is seen. The administrator must fill in data on all starred (*) lines, as these are required fields. Enter the profile’s Username, First Name, Last Name, and email.

The Generate Random Password option triggers the system to generate a password. The string will meet the requirements set for the site. When the option is selected, the view changes to remove the password configuration area.

Password requirements are configurable on a per site basis. For example, the requirement may be that the string contain a minimum of 8 characters, at least one upper case and one lower case letter, at least one number, and a special character, such as: ?, $, #, or *. (The user can change his/her password after login, though the restrictions will still apply.)

If the generate password is not selected, the system will require that the user change their password on their next login. This ensures that the password is secure.

When finished, click Update to add the user. The system will check that the password string meets the set requirements and will display an error if the validation fails. The error will include the configured requirements as a prompt.

Complete the fields and select Update. A success message is seen.
Once the user’s login has been defined, their Permissions must be set. Select the **Permission** tab above the user’s information.

At initial installation (before the customer adds custom definitions), there are two user roles: **User** and **Admin**.

**User**
The default user role is assigned the Read-only Permission group. Users can essentially view but not create or edit system elements. Users can view topologies, dashboard sections, and system notes, and acknowledge alarms. Users can view the resource’s full console, including data point values and options, but cannot commit any settings or changes. Users can also view Instructions (commands) in the full console, but commands sent by the user will not be executed or saved. Users also do not have access to the Editor area seen in the user name’s context menu.
**Admin**

The admin role is defined by the Read-Write Permission group and can both read and write to all areas within the system. Admins can manage resource data point settings, clear alarms, modify resource settings, and send commands. This role also manages system users (both other administrators and user/operators), alarms, translators, resources, and services; and can import and create topologies.

Any other roles seen in an installation will be customer defined after system setup.

Select a role and click **Update**. A user updated success message is seen. (Note that every user must be assigned a defined system role, even if the permissions are going to be modified.)

**Modifying a User’s Permissions**

Administrators can define precisely what items a user can view, create, and delete within the interface. The process is similar to creating a Permission Group.

For example, this user will be allowed to view and manage specific services, mask/unmask alarms, and create new alarm preferences in their Preferences area.

In the user’s Permission tab, click the + symbol below the Permission table. From the Class, select GUI Permissions to encompass the various items within the system, such as services, resources, preferences, topologies, transports, and alarms. (There are other options, such as topology, where one or more system topologies can be selected; and resource, where all the resources are listed).

From the Type table, select if the user can view, create, and/or delete an item within the NMS UI. In this instance, the view enables the user to view the alarm, create allows the user to mask, and delete to unmask the alarm.

Next select the Instance type. To follow this example, select Alarms and Permissions.
Select **Update**. The permission to manage and mask/unmask alarms and define new alarm preferences are added to the user.

Another GUI permission seen is **Dashboards**. This permission determines if a user can modify the NMS dashboard.

In order to change or create custom dashboards, the user must have the create permission. To remove a defined dashboard, the user must have the delete permission.

A default dashboard can also be assigned to, and managed with, a user role. This is described in the [Viewing/Editing a Role](#) section earlier in this manual.
Editing a User
To edit a user click the user’s icon in the Other Users list. If changes are made, click Update to commit the new value.

Deleting a User
Administrators can delete NMS users at any time. Once a user has been deleted, he/she cannot log into the CodeMettle NMS system.

To delete a user:
1. Expand the Other Users list in the left pane by clicking the arrow.
2. Select the user from the list.
3. Click the – option.

The system will request a confirmation. The action must be confirmed before it will be committed.

When that user attempts to log into the system, the system returns a Failed! status in the login window.

Disabling/Deleting Inactive Users
User management includes an option that will automatically disable or delete a user if they have not logged into the system within a certain number of days. When a user is disabled, they are not able to log into the system.

When this occurs, the Disabled checkbox is activated on the user details page.

If needed the administrator can enable the user again to allow them access. If the deleted option is chosen, the user profile is removed completely. If either option is set to 0 (zero), the functionality is disabled. Administrators are also exempt from this check.

The check for inactive users occurs at midnight every day. The system will compare the inactive setting against each user’s last activity time, which is updated upon the user’s login, excepting the users found in the exempt user list.
CAMs

The Correlation and Automation Machine (CAM) is the core module of the NMS. The CAM is an extremely powerful module that communicates with resources, offline systems, and data sources. The CAM acquires data, normalizes the data, performs correlation and pattern detection, and enables automated actions to be taken based on the results of its analysis.

CAM installation is part of the core NMS configuration so this is not part of system administration. However, the NMS administrator can rename the instance to more clearly identify the associated site.

To view the CAMs being monitored, go to the System Administration area by selecting the link in the user’s contextual menu. If the System Administration area is already open, select the left arrow beneath the window title to return to the System Administration home dashboard.

Click CAM from the System Administration area.

The page lists all the CAMs in the monitored network. If the network is comprised of one site, there will be one CAM. If the monitored system is a wide area network with multiple sites, there may be multiple CAMs listed. Note, however, that there is not a one-to-one correlation of CAMs to sites within a network. A CAM can manage one to many locations.

By default, each CAM instance will be identified by the name CAM. Administrators of a distributed network and/or multiple CAMs will need to know what name represents which module so the correct CAM is selected when setting up system components; and so may want to rename each CAM to be more descriptive.
Currently, the + and – links in the left lane are not supported. CAMs are added and removed in the back end by CodeMettle personnel.

To view the current version for a CAM installation, select the instance in the left pane. (If there are multiple CAMs, select the arrow to the left of the CAM label that will be seen first to expand the list of entries.)

The module’s current name and software version (the version of the NMS system overall) is seen. To change the CAM’s name, enter the value into the Name text box and click Update.

To return to the System Administration home page, click the left facing green arrow in the left pane.

Note that if changes are made (essentially the CAM’s name), the CAM must be restarted.
Managing Transports

Transports are the physical interface to the resource and provide the avenue for low-level communications to managed entities. Since there are different kinds of resources and protocols, there are different kinds of transports. Example transports include SNMP and TCP.

Because they are so closely aligned with resources, transports are accessed in association with Resources. However, since Transports are needed to define resources, transports should be defined first.

1. Go to the Administration area.
2. In the System area, select Resource.
4. The currently defined transport types are listed.
Filtering

For both resources and transports, the list can be long so the NMS provides a search text box just beneath the column header. The system returns matching strings, highlighted in bold, as characters are entered.

Viewing Transport Details

With the Transport tab selected, click an item in the left pane to view its details.
The State: line at the top of the pane indicates when the transport was last started (or if the transport is currently Stopped). At the bottom of the pane is the **Misfire Threshold**. This sets the percentage of misfire occurrences before a fault/alarm is triggered and can be modified regardless of the transport type.

**Starting/Stopping a Transport**

A transport can be stopped and/or started within the interface. Note that this will affect all resources using this transport.

To start or stop the transport, click the appropriate command above the details.

When the CAM is started, it checks each transport’s startup state value. If the data point does not exist or if it is set to START, the CAM will start the transport. To set a transport to stay stopped if the CAM is re-started, CodeMettle has added a configuration data point with the key “transportStartupState”. With this data point, when a start instruction is sent to the transport, the value is set to START. Likewise, when a stop instruction is sent, the transportStartupState is set to STOP.

However, if the data point exists and it is set to anything other than START, the CAM will not start the transport. This ensures that CAM actions will not restart the transport prematurely.
Adding a Transport

Click the + option beneath the Transport list in the left pane.

The fields displayed are based on the Transport Type selected. Available transport types are:

- SSH Client
- TCP Client
- SMNP Manager
- Generic Transport
- UDP Client

The different views are seen below. No matter what type of transport is selected, all of the fields, except Description, in each console are required.
Transport console for Generic Transport and SNMP Manager:

- **Name**: identifies the transport
- **Description**: additional description
- **CAM**: the CAM that this transport will be added to
- **Transport Type**: Generic, SNMP, serial port, etc.
- **IP Address** (*TCP or UDP client only*)—IP address of the resource the transport is connecting to
- **Port** (*TCP or UDP client*)—Port number of the resource’s IP address
- **IP Version** (*TCP or UDP client*)—Ipv4 or IPv6
- **Debug Level**—sets the level of event messages that will be output to the CAM (NMS) log

A variable on the configuration above is SNMP over TCP, allowing SNMP resources to be polled over TCP. To set this up, send a Boolean parameter with the key “SNMP over TCP” = true is sent as a data point instruction; then stop and restart and transport. The same is true when changing from UDP to TCP.

The result is a configuration data point for SNMP transports with SNMP over TCP. (This defaults to false unless the parameter or other change is sent.)

The transport console for the SSH Client is:
The transport settings are:

- Name—identifies the transport
- Description—additional description
- CAM—the CAM that this transport will be added to
- Transport Type—SSH Client.
- SSH IP Address—IP address of the resource the transport is connecting to
- SSH Port—Port number of the resource’s IP address
- SSH Username—Username used to log into the SSH console
- SSH Password—Password used to log into the SSH console
- SSH Verify Persistence—Verifies the connection is active through polling; if no activity is detected after a certain period, the connection is closed
- Debug Level—sets the level of event messages that will be output to the CAM (NMS) log

Once the settings are complete, click Update.

**Editing a Transport**

When a transport is selected from the pane, its details are seen but none of the fields (except the Misfire Threshold) can be modified. Consequently, all other fields are disabled and greyed out in display.
Deleting a Transport

To delete a transport from the NMS, select the Transport entry in the left pane and click the – option.
Managing Resources

The resources area is an important section. It serves multiple purposes; namely:
- As a means to see what resources are present at each CAM (i.e. site)
- As a means to know what translators and transports each resource is using
- As a means to add and delete new resources
- As a means to edit a resource (e.g. change name, transport, translator)

Select the **Resource** icon from the Administration Area.

This lists all the resources for the entire system.
Filtering

Resources can also be searched by name in the text box just above the Name results. The system will dynamically search against the string as characters are entered.

Select a name from the list to access the device.

Viewing a Resource's Details

Select a resource in the left pane. The resource’s details will appear to the right.
There are two areas for each resource: Details and Properties. The Details view (shown above) displays the resource attributes, such as Name, Description, the managing CAM, Transport, Translator, and (if applicable) the Device Address.

The Properties tab manages the resource’s ID for a topology template and to set up database keys.

To view another resource’s details, select that instance in the left pane. The right pane changes to reflect the new selection.

To access the resource’s console, click the icon in the left column.
The resource console is described in the *NMS Operator Manual*. 
Adding a Resource

With the Resource tab selected, click the + option in the left pane.

Required fields will depend on the transport chosen for this resource.

Enter the Name that will identify this resource, followed by a Description.

Select the CAM for this resource. (If only one CAM is available, no action is needed here).

Next choose the type of Transport and the Translator that the resource will use from the drop-down lists. Depending on the choice, this may change the screen. For example, the screen shown above is for an SNMP transport. This may change if another transport is chosen. The Translator drop down is in alphabetical order to aid in locating the correct driver.

The Debug Level sets the log level that will be recorded to the CAM log.

Complete the fields for the provided screen. When complete, click **Update**.

The Resource will be added.
Adding Properties

The Properties tab can be completed after initial configuration, as these values are not required for the resource to operate.

Click the Properties tab.

The Template Ref Id(s) assigns one or more values to this resource that can be referenced in a topology template. The value here will be used when adding this resource to the template in the Topology Editor. The two values must match for the association to succeed.

(This will be described further in the Managing Topologies chapter.)

Keys are used to quickly find the specific resource in the database. Enter the key (field) name and its value in the first row and then click Enter on the keyboard.

When the properties have been added, click Update. The system displays a message that the object was updated successfully.
Editing a Resource

Choose a resource from the list.

Any of the fields here and on the Properties tab can be edited.

When the changes are made, click **Update** to apply the edits. Select **Cancel** to return the fields to the previous values and dismiss the window.

Deleting a Resource

With the Resource area displayed, select the resource to be removed in the left pane.

A confirmation message is seen.
Select **Yes** to confirm the action, or **No** to dismiss it.

**Configuring Resources**

As explained in the *Operator Manual*, resources are comprised of data points and attributes. Data points provide the measuring points that are used to determine if the resource is operating normally or is in an alarm condition. As such, data points provide valuable information to the operator monitoring the system. The NMS enables the administrator to configure any data point to appear in one or more views seen when navigating within the interface. Both users and administrators can choose where the data points will appear; but only administrators can choose what data points are service affecting.

To access the console from the administration area, select the Open Resource Detail Form icon in the left column.

Select **Details** from the left side.

Select the arrow to the left of the data point to be configured. This opens the area where the attributes of this data point can be configured. In the example below, how many poll misses is also an attribute, as it describes the data point. Its current value is seen.
If the attribute does not have the wrench icon, it is not a configurable data point and so it will not have the instruction pane when the arrow is expanded. It will only have the attributes pane.

Click the **Attributes** tab to set the view options. View options and whether an alarm will be considered service affecting are attributes.

Click the + arrow in the Categories pane.
First, the administrator can choose to have the display for ONLY this resource by selecting the check box next to the desired view. For example, selecting the checkbox next to **Show on Node Select** will cause the AcceptablePollMisses status to show ONLY when this specific node is clicked. Similarly, unchecking the check box will cause the data point to no longer show on that navigation option for ONLY the resource of this resource console.

*For more information about views please refer to the Operator Manual.*

Second, the administrator can choose to display this data point for ALL resources of the same type by clicking the +**All** option.

Third, the administrator can click the –**All** button. This will cause the data point for ALL the resources of the same type to not display in the chosen view.

Fourth, select whether this will be service affecting. (This is explained in detail in the [Setting to Service Affecting](#) section.)

Other resource configurations can be set by selecting the + symbol in the Attributes pane. What options are seen will depend on the data point selected. Example data point attributes include whether an alarm is triggered if the data point’s value changes and whether an alarm triggered by this data point will be masked automatically.

**Managing States**

Administrators can also set multiple resources in and out Maintenance at once. As seen, individual resources can be placed in Normal or Maintenance state at the bottom of the resource’s full console. Here, administrators can set any number of resources into Maintenance by selecting the checkbox in the **Maint** column.
Select the box again to set the resource to normal.

All resources can be selected at once by choosing the box above the resource list, next to the **Maint** header (shown to the right). When this method is selected, a confirmation popup is displayed.

As the resources are set to the Maintenance state, the individual boxes become checked. The control box is also selected. Click the control box again to unselect the maintenance mode and toggle the state of all the resources.
Managing Translators

Translators (sometimes referred to as drivers) allow the CodeMettle Network Management System to interact with network entities and database objects. Translators handle communications between the resources and CAM. Additionally, they convert the raw entity data into human-intelligible data for delivery to the Enterprise Service Bus (ESB), which delivers the message to the NMS.

In the System Administration area, click Translator.

Currently defined translators are listed on the left.

Viewing a Translator

Select a translator from the list.
Adding a Translator

1. Click the + option in the left pane.
2. A file explorer window opens to allow browsing to the translator file for upload.
3. When a valid file is found, click **Open**. When the file has been uploaded, the instance is added to the Translator list.

4. Select the new translator from the list in the left pane.

5. The details section of the Translator dialog allows system administrators to set the description, upload the translator's equipment manual, and upload an image that will be used for display in the Translator's NodeCalloutForm.

   The fields seen are:
   - **Name**—name of the translator. This will be populated by the translator’s filename.
   - **Description**—additional description for the translator
   - **Version**—the driver's version
   - **Mod Time** – (this is populated by the NMS)
   - **MD5 Hash** – (this is populated by the NMS) this contains the calculated MD 5 hash of the translator contents, as calculated by the NMS
   - **Manual**: means to upload the equipment manual for this translator
   - **Image**—means to find and select an image to be associated with the resource type that will use this driver. The image will appear on the Node Select.

   (The **Update On**: lists identify the resources and CAMs associated with this translator and are used to push translator updates across the system.)

6. If any fields are modified, click **Update**.

   *If the new translator has the same name and version of a loaded translator, the NMS will automatically increment the version of the new one. If the user attempts to change the translator name or version to match the existing values, an error is returned.*
Updating a Translator

1. To add a new version of a translator to the system, select the translator from the left pane and click the **Content** tab.

2. Click **Import** to open the file browser.
3. Click **Open** when the appropriate file is located.
4. The file will be uploaded and the existing translator will be updated.
5. Click **Update** to commit the new file to the database.
6. Click the **Details** tab.
7. Update the details as needed and click **Update** to save these changes.
8. A success message is seen.

(Note: The **Content** tab also allows the export of the translator from the NMS.)
Rolling Out Translator Updates Across the System

There are two “Update on” lists. The first (left side) shows all of the CAMs within the system. The second (right side) shows all of the resources within the system that have the same Translator filename and Translator key. This allows an administrator to easily roll out Translator updates to any or all of the CAMs and Resources that have this translator within the system at once.

To update a CAM or resource with the new version:
1. Select the object(s) in the Update On: lists. Multiple items can be selected by holding the command key while clicking the entries.
2. Click the Update button.
3. The new version and modifications are pushed to the selected objects and applied.
Managing Racks

The Racks area enables administrators to change the height of existing racks. Racks are added to the system via data points; any resource with a defined rack name, height, and position data points will be automatically added to the page when the instance is created.

*Note that the rackHeight data point refers to the device height, not the actual rack height. Unless otherwise specified, the default rack height will equal 48.*

Viewing Racks

Click the **Rack** icon in the administrator home page.

The Rack page lists defined racks. This includes rack records in the configuration database as well as any data points that include a key=rackName attribute.

Clicking the + symbol at the bottom of the left pane reiterates that racks can only be added by data points.
Editing Racks

The whole purpose of Rack page is to enable changing the height of existing racks. This is to accommodate systems that require rack heights other than 48 RU.

If a rack’s height is changed to anything other than 48, a Rack record is written to the configuration database. Conversely, deleting a rack from this page or setting the height to 48 will remove the Rack record (if it exists) from the configuration database; however this will not affect data points. The rack will still exist, shown at the default height (48RU).

In the left pane, click the Rack to be edited.

Enter the rack’s height setting. Updating a rack height to anything but 48 will cause the record to be written to the configuration database. Deleting a rack or setting its height to 48 will remove the rack record (if it exists) from the configuration database; but this will not affect the data point itself, as the rackName still exists.

Note: rack names, heights, and positions of “0” will not appear on the Racks page.
Managing Services

Services represent the physical devices and their connected data path that enables the desired functionality. The key element is the path of data that runs from point to point.

*For the purposes of NMS manuals, the words “service” and “service group” are the accepted terms. CodeMettle recognizes that other terms may be used to represent these entities, such as circuits. Custom labels can be assigned to the NMS forms with a customlabel.txt file in the custom assets directory of the system files. To find out more or request a custom label, please contact your CodeMettle representative.*

Adding a Service

There are three ways to initiate adding a service. The first shown is from the Inventory Tree list found in the Views area of the NMS operator interface.

1. Click the Views tab and select an item from the dropdown list. In this example, the selection is **Alterna Platform**.

2. The network topography view is displayed. The Show/Inventory tree icon is in the upper left corner of the window. Click the icon.

The resources in that topology are listed.
The second option is directly from a node on a topology. Control-click (on a Mac) or right click (on a PC) a node in the topology diagram and choose **Create New Service** from the popup menu. The Add Service popup immediately appears, since, unlike the other methods, the starting resource has been selected.
The third method is to start in the Administration → Services area. With the Services tab highlighted, select the + symbol at the bottom of the left pane.

The resulting popup window has two columns: topologies on the left and resources (nodes) on the right. The Node column is listed alphabetically with its corresponding Topology on the left.

<table>
<thead>
<tr>
<th>Topology</th>
<th>Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>bdcast</td>
<td>A/B Sw1</td>
</tr>
<tr>
<td>bdcast</td>
<td>A/B Sw2</td>
</tr>
<tr>
<td>bdcast</td>
<td>A/B Sw3</td>
</tr>
<tr>
<td>Alterne Platform</td>
<td>Alterne HPA A</td>
</tr>
<tr>
<td>Alterne Platform</td>
<td>Alterne HPA B</td>
</tr>
<tr>
<td>Alterne Platform</td>
<td>Alterne HPA Sw1</td>
</tr>
<tr>
<td>Alterne Platform</td>
<td>Alterne Switch Controller</td>
</tr>
<tr>
<td>Alterne Platform</td>
<td>Alterne U/C 1</td>
</tr>
<tr>
<td>Alterne Platform</td>
<td>Alterne U/C 2</td>
</tr>
<tr>
<td>Analog Modulators</td>
<td>ANA MOD 1</td>
</tr>
<tr>
<td>Analog Modulators</td>
<td>ANA MOD 2</td>
</tr>
<tr>
<td>Analog Modulators</td>
<td>ANA MOD 3</td>
</tr>
<tr>
<td>Analog Modulators</td>
<td>ANA MOD 3</td>
</tr>
<tr>
<td>CableStar 2 HD</td>
<td>Art B HPA Sw1</td>
</tr>
<tr>
<td>Antenna BB</td>
<td>Antenna BB</td>
</tr>
</tbody>
</table>

Note that some nodes have a green + symbol to the right while some topologies have an arrow to the left. If the node (resource) has multiple ports (connecting points for a service) this is displayed in the
context of the topology. However, if the connecting point is directly to a node, it is seen (and can be selected) directly to that resource. No further context is needed.

3. The green + symbol represents a node or point where a service can begin. Select the + symbol on the right side of the list. If a resource does not have + symbol, it may represent another network, or a resource with multiple ports that can be a point within the service path. Instead of a plus symbol on the right, these will have an arrow on the left. Select the arrow to expand the item and view the available ports that can be utilized. Each port will have a + symbol to the right.

*Remember that services can only be started at points designated with the plus symbol. If the plus symbol is not seen, select the arrow in the Topology column to expand the resource’s ports.*

To quickly find the specific Topology and resource that is the desired start point for the service, enter the Topology name in the Search text box in the left column. Results are listed as characters are entered.
When the topology is selected, the list is limited to that selection and its resources.

Once the listed item is eligible to be a service point, the + symbol is displayed. Select this to start the process.
The Add Service popup appears.

4. Enter the Service Name.

5. To define a property for the service, type the Key and the correlating Value into the columns. Properties enable the database to keep track of specific data related to the service (not a device in the service).

6. Click **Next**.

7. A list of available resources for this service is listed. This is based on the resources that are linked to the originating node.
8. The ending resource is self-discovering as this may change based on switch settings.

9. Select **Done**.

**Setting to Service Affecting**

Service affecting alarms are alarms classified by the system administrator to warrant them being service affecting. Any alarm can be classified as a service affecting alarm.

There are two ways to configure service-affecting alarms: during the initial service creation and in the resource full console after the service has been created.

**During Service Creation**

1. After the beginning node is selected, a list of resources that could potentially be part of the service is seen on the left side of the window (based on auto discovery and specific settings at a given time).

2. Select a resource/node that will trigger a service affecting alarm.
3. Select one or more events that will trigger a service affecting alarm.
4. Click **Done**.

**To a Data Point**

Alarms can be set to service affecting at the data point level in the resource’s console. There are advantages to assigning a service affecting alarm at the data point level (instead of a service level). Using this method gives the administrator additional options: if multiple services are associated with the resource, they can all be managed at once (creating a multi resource alarm).

1. Select a resource node.
2. The Node Select view is displayed.

3. Click the Full Console icon.
4. Click the **Details** tab.
5. Click the arrow to the left of the data point to be modified.
6. Click the **Attributes**.
7. Click the + symbol in the Categories pane.

The list of views also contains a Service Affecting configuration option. When this is selected, the NMS is told that if the resource goes into an alarm, a service or services will be affected.
There are several options here.

**Managing Alarms and the Multi Service Resource (MSR)**
Resources can support multiple services. Administrators can choose which services will be noted as affected if a multi service resource goes into an alarm condition. The purpose of this feature is to prevent a multitude of services from alarming when an MSR goes into alarm. This allows for assignment of an alarm to specific service (or services), versus all services where the resource is present.

To add an alarm as a service affecting alarm to a multi-service resource, click on the Select services affected by this alarm icon (the same icon chosen when managing alarms for a specific resource). That will bring up a pop-up as seen below.

Click on the Individual radio button(s) to associate the service(s) this alarm is associated with and click Submit.

The Service Affecting radio button is now selected.

**Removing an Alarm From a Single Resource**

To remove a specific resource’s alarm from being service affecting, administrators click the – icon in the Service Affecting row.
Managing Alarms with Resource Type

Note: remember that resource type includes the unit's manufacturer and model; not just what the type of unit or what it does within the network.

Click the +All button to add a service affecting alarm to a resource type. The alarm will be seen with ALL resources of the same type and model.

Click the –All button to remove a alarm from a resource type. This removes the service affecting alarm from ALL resources of that type.

Adding an Alarm to a Single Resource

To add an alarm to a specific resource, click on the highlighted icon. A pop-up is seen. Click on the All radio button or the All command and click Submit.

This is applicable if a resource only has a single service associated with it. Resources that have multiple services are described above in the Managing Alarms and the Multi Service Resource.

Applying a Rule to a Service

Administrators can add (or remove) a rule from a service. Rules themselves are managed in the Rules area of the Administration area. Once defined, they are included in the Rule dropdown list.
Note: This action can only be performed in the Administration→Services area.

1. Select the service from the list.
2. Click the arrow of the Rule drop down list to expand the options.

3. Select the rule to be applied.
4. Click Update.

To remove a rule, follow the same procedure but instead of selecting the rule from the drop down list, de-select it.

**Adding the Service to a Group**

Service groups are visual groupings of services within the interface. A service can be added to a group here by selecting a group from the drop down list (if it has been defined) or by typing the group name into the text box. If the name is typed in, the group will be added.
Service groups are covered in greater detail shortly.

Setting a Pruning Name

The next option is setting one or more pruning names to the service. Pruning names are used to track a service after it gets split passing through a combiner and after it passes through a splitter. Pruning names assign a certain output to a service, so the name has to be assigned to an output as well as the service.
Multiple names can be added, separated by commas.

**Adding an Image to the Service**

Administrators can assign a logo or image that will represent the service. Images can be easier to recognize quickly than a set of characters within a string.

1. Click the **Administration** option in the user name context menu.
2. Click the **Services** icon.
3. Select a service from the left pane.

*If an image has already been selected, it is seen below the Image option. This will be replaced if another image is selected.*

4. Click **Select** by the Image: label to assign a logo or to replace an exiting image.
5. A computer find/browser window is displayed.
6. When the file is located, select it and choose **Open**.
7. Click **Update** to commit the change.
Enabling Stream Viewing in the GUI

The NMS enables viewing a Flash video of the service’s stream within the GUI. In the Service view, a Play button is displayed in the top left of the view, which will evoke a video player in a new window.

To enable this, a video URL must be defined for the service by entering the value into the Video URL field. (Unless there is a URL entered, the Play button will not appear.)

```
Video URL: rtmp://127.0.0.1:1935/media/mp4:video.mp4
```

Configuring the Alternate Start Points

Alternate start points are actually additional start points. For example, site A starts from the left of a topology and finishes on the right at the satellite link. Site B starts from the left as well but perhaps on a different, or even the same, topology and ends on the same satellite link. At that meeting point, the system combines the two services into one. Click the green + symbol beneath the Alternate Start Points box. The Add Alternate Start Point pane appears. This is identical to selecting the starting node from the administrator view (all of the system’s resources are listed with their topologies).
Select a green + symbol. The point is added immediately.

Removing a point is a simple matter of selecting the entry in the box and clicking the red – button.

**Configuring the Backup Service Points**

In order for a network to run successfully, services must be performed regardless of individual resource status. To provide a level of redundancy, backup service paths can be configured. This can only be initiated from within the service details view in Administration.

1. Click the + symbol beneath the **Backup Points** box.
2. The list of resources with their topologies is provided. Click the + symbol to the right of a point.
3. The point is added to the Backup points area.
4. When the different points are added, the backup data path can be seen when the primary service (the service that has the backup points) is selected in the Views menu. (Whether the backup paths are seen is set in the My Preferences page. If the backup paths are not seen, go there and verify the option is selected.)

![Backup nodes and path]

The nodes and links are displayed at 30%, which makes them appear faded compared to the primary. This is especially evident in the navigation inset view.

Creating Service Groups

Services can be visually grouped within the Service Status area in the NMS Dashboard. An example of this visual separation is shown below.

![Service Status]

Groups are created and configured in the Services area.

1. Click the Administration option in the user name context menu.
2. Click the Services icon from the System Administration dashboard.
3. Select the Service Groups tab in the left pane.
4. Click the + symbol at the bottom of the pane.
5. A new (empty) Service Group details area is loaded into the right pane.

6. Enter the **Group** name into the text box.
7. Rules can be applied to service groups as well as individual services. If desired, select a rule from the drop down list.
8. Next select the services that will be part of the group from the table below. If needed, use the text box at the top of the list to search for and find the desired services. As characters are entered, the list is filtered to match the criteria.

<table>
<thead>
<tr>
<th>Name</th>
<th>Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBC</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Services</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>Go to Page:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BBC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BBC 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BBC 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BBC HD 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BBC HD 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9. When the services have been selected, click **Update**.

10. A “Service has been updated” message is displayed briefly for each of the services that have been added. If 10 services were added, 10 popup messages are displayed.

11. The group is added to the left pane.
Managing Service Groups

1. Select the Service Groups tab in System Administration -> Services area.
2. Select the group.
3. The Service Group details view is seen. Any of the fields can be changed.
4. If changes are made, click **Update**.
Managing Resource Groups

Administrators can create and manage resource groups within the NMS GUI. Select **Group** in the System area of the Administrator dashboard. The list of defined groups is seen. If no groups have been defined, none will be seen.

**Creating Resource Groups**

Select the + option at the bottom of the left pane.

Name the group and click **OK**. The instance is added to the left pane. The edit group pane is loaded into the right. Editing a resource group is essentially selecting what resources are group members.

Select the resources to be part of the group and click **Update**.

**Editing Resource Groups**

Select an entry to view what resources are members of this group (or view the details of the new group). All of the resources are listed. Member resources will have a check in the check box.
To add a resource to the group, check the box. To remove the resource, uncheck the box.

To quickly find resources, enter a search term into the text box above the list.

Resource groups can be renamed. Enter the new value into the Name text box and click Update. This will not affect current memberships; the group name will be updated across the system but no other changes are affected.

**Deleting a Resource Group**

Deleting a resource group only removes the logical grouping of the resources. The resources themselves still exist.

Select the group to be removed and click the – symbol in the left pane. A confirmation message is seen.

Confirm the action by selecting Yes. The entry is removed from the list.
Managing Shared Modules

A shared module represents functionality that is shared/used among translators. When seen as an entity, a shared module is a building block that a translator can use; put another way, it is a translator used by other translators.

Select the Module icon in the Administrator dashboard.

The list of shared modules is seen.

Viewing the Module

Select a module from the left pane.
The module’s details include its name, the file path, when the file was last modified, its MD5 Hash, and the option to update any components that uses this module. Little can be changed about the module, as these details are set when the file is uploaded.

Click the Content tab in the right pane.
The Shared Module Content view displays the instructions/rules/settings shared by the different modules. The content seen will depend on the type of module.

A new file can be imported or the existing one exported from the NMS by selecting the appropriate command on the left side of footer. If a new file is imported, select **Update** at the bottom of the display to commit the new version.

**Adding a Shared Module**

1. In the Shared Module area, select the + symbol in the bottom of the left pane.
2. A file explorer window opens to allow browsing to the file.
3. When the file is selected, click **Open**.
4. When the file has been uploaded, it is added to the list in the left pane.
Applying Commands

Commanding allows the administrator to set data point values and make configuration changes to resources. In CodeMettle, commands can be executed either via the Node Selection box or from the Resource Console. Any data point that can be modified will have a wrench icon as pointed out by the red arrow (🪜) in the screen below. Clicking on the icon will bring up a popup where you can enter the value. Clicking Send will execute the command. Clicking Cancel will close the popup without executing the command.

The screenshot below displays setting a data point from the Node Select view.

The next screenshot illustrates setting a data point from the full console.
The NMS supplies other command options as well, known as instructions. These are available as a tab in the Details view of the full console; in the Favorites pane on the full console dashboard; and in the node select view. (What instructions are seen is also configurable. This is described shortly.)
For example, the administrator can request a list of polls or poll statistics, trigger an immediate polling event, and re-load a resource.

*If the instruction includes a number parameter and an out of range value is entered, a pop up error is displayed. This prevents invalid instructions from being sent without the user’s knowledge. The popup appears if the value is less or more than the acceptable range for that parameter.*

To execute an instruction, select the arrow to the left to expand the command.
The NMS is designed to expand the instruction so any criteria or attributes of the command can be entered. If further details are needed, the field or fields that need defining are listed (such as in the example above). Enter the value and click **Send Instruction**.

If no further details are needed, no fields are seen.

Click **Send Instruction**.

A confirmation is seen.

Confirm the action to send the command.

Like data points, an instruction can be configured to display in specific areas, such as the Node Select, Tooltip, Favorites, etc. Select the **Categories** tab.
Which categories are seen will depend on the type of instruction.

Select the checkbox to see this instruction only for this data point on this resource.

Select + All to see this instruction for this type of data point anywhere it occurs when the applicable view is evoked.

Select –All to remove the instruction from the view for all data points.

When selected, the instruction is available in the view directly. Essentially, this creates a shortcut to a specific command from a defined area.
Managing Rules

Rules define system behaviors under certain conditions or in response to specific actions. Rules can be imported and exported from within the NMS GUI.

In the System Administration area, click the Rule icon.

The current rule sets are listed in the left pane.

Select the rule set from the left pane to view its Details.

Adding Rules

1. Click the + option in the left pane.
2. A file explorer window opens to allow browsing to the rule file for upload.
3. When a valid file is found, click Open. When the file has been uploaded, the instance is added to the Rule list.
4. Select the instance to view its Details.
The details section of the Rules dialog allows system administrators to set the description, version, and CAM associated with the rule. The Name, Mod Time, and MD5 Hash are set by the NMS system during installation/update.

If the new rule has the same name and version of an existing one, the NMS will automatically increment the version. If the user attempts to change the rule name or version to match the existing values, an error is returned.

**Updating Rules**
To add a new version of a Rule file to the system, select the Rule from the left pane and click the Content tab.
1. Click **Import** File to open the file browser.
2. Click **Open** when the appropriate file is located.
3. The file will be uploaded and the existing file will be updated.
4. Click **Update** to commit the change to the NMS database.
5. Click the **Details** tab.

If changes are needed, click **Update** to save the changes.

(Note: The Content tab also allows the export of the rules file from the NMS.)

**Applying Rules**

Rules are imported here but applied to the applicable elements in the element’s details page. Rules from the entity are also removed in the same page.

**Rolling Out Rule Updates Across the System**

On the Details tab, there is an Update on list at the bottom of the window. Actually there are two “Update on” lists. The first shows all of the CAMs within the system. The second shows all of the resources that are affected by this rule.

To update a CAM or resource with the new version:

1. Select the object(s) in the **Update On**: lists. Multiple items can be selected.
2. Click the **Update** button.

3. The new version and modifications are pushed to the selected objects and applied.

**Warnings**

A warning is returned if a rule takes too long to execute. What is too long? This is determined by the slowRuleThreshold data point. The default (also specified in the BaseRule setting) is 2,000 ms, but is configurable. When a rule's execution time exceeds the slowRuleThreshold, a warning is written to the CAM's log and a slowRuleFault is triggered, another resource configuration data point. The severity of this data point is 1 (minor). The value contains the translator and the rule name. This data point also includes an instruction to clear the fault.
Managing Topologies

Topologies provide a graphical view of the network’s design and components. Viewing a service or site topology can quickly provide both the status and relationship of each component represented. NMS administrators can create and edit topologies within the interface using the Code Mettle editor application, import topology files created by other applications, including Visio, into the system, as well as choose which topology is the default starting view in the Editor area.

Select the Topology Editor option in the user name context menu.

When first opened, the Editor’s Palette view is seen. An Untitled canvas is displayed on the right, and a Node element is on the left.

There are also overall topology properties; such as the Background Map, which is a dropdown list of map illustrations that can be applied as a background to the topology, and the topology’s link properties.
Another topology property is the showInList. If the diagram has this property and it is set to false, the topology is not included in the Views menu.

To remove a topology from the list, click the + symbol in the Properties area. Type showInList into the key and false into the value.

To save the change and make them public, click file--&gt;Publish Diagram. A message is seen that the topology has been saved.

**Editing a Topology**

While topologies can be created in the NMS editor, it is expected that the editor will be used to view and modify topology designs imported into CodeMettle from an outside application, such as Microsoft Visio.

*Note that if more than one topology file is imported from Visio, the first one within the import is considered the Primary Topology by the NMS and the (Primary) designation will appear in the Views Topologies list.*

To view the topologies currently defined on the NMS, click the Topologies arrow in the left pane to expand the selections.
Administrators can select to view/edit any of the topologies listed by selecting the instance’s pencil icon (edit) in the right column of the Topologies area.

Since it is possible the rendering will be larger than the window, look for the topology to appear in the navigation subset (on the right side of the pane) and work from that area to bring specific areas into view.

To add an element, drag the node or other entity from the left pane to the right. Position the element where it is desired in the topology.
When an element is added, the left pane changes to show its details. There are three tabs: Node, Ports, and Properties.

The default tab selected is Node. Whatever details are added here will appear as the Properties of the element. The details will depend on the type of element being added. Defining factors include whether the node’s name will be hidden when displayed in the topology view in the NMS GUI (Hide Name); the text seen when the cursor is hovered over the node; the Shape Type that will be rendered within the topology within the NMS GUI; the Referenced Object, which associates the icon with a resource on the system; its Click Class, which defines what is seen if the object is selected; and the Width and Height of the icon when rendered in the Service view.
If defining a node that links to another topology, the name (which is the text displayed on a selected node) can be especially useful. Instead of naming the node a name similar to multiple other node instances, a name can be assigned that makes clear to the user that this node is a link to another topology.

The Click Class property tells the system what type of view will be displayed when the object is selected. The default value is Node Form (i.e. Node Select).

The screenshot below represents the Alterna U/C 1 node. Its Click Class setting is None (or Node Form, which is applied if a class is not selected).

Of course, a link’s properties are different from a node’s. When selected in an existing topology, the source and destination nodes are defined and cannot be changed. However, the Source Port and Destination Port can be specified. In addition, the link can be hidden when rendered (and made visible now in the editing process). The link’s arrow characteristics, any mouse over text, and whether the link is given a permanent color can also be defined.
A crucial part of integrating a topology with a network is the association of various icons to a specific resource/element within the network. To see established associations or to set up one, select a node within the topology.

Select the resource or entity the node will represent from the Referenced Object drop down list in the left pane.

Select the resource to associate the physical hardware with its logical representation in the topology. If the node represents a network, topologies are included at the bottom of the list.

Select **Publish Diagram** from the Editor’s **File** menu to save the changes.

**Connecting to Another Topology**

A port-to-port connection to a resource in one topology to a resource in another topology can also be established. This enables a service to cross/transcend multiple topologies/networks.

Select **Tools** ➔ **Cross-Topology Connections**.
Adding a connection is established by selecting a Source and a Destination. The Source is seen in the topology currently in view; the Destination is the topology that will be loaded into view.

Select the Source +. The Cross-Topology Connections toolbar appears.

The Choose Source page appears.
When the source is selected, it appears in the Source area of the toolbar.

Repeat the action for the Destination.
Though the points have been selected, they must be approved. Select the green check in the toolbar to add the entry. The Cross-Topology Connections window appears again, but now includes the new connection.

(To continue setting up connections but not keep the current route, click the red X instead.)

When all of the connections have been created (and approved), click **Save**.

*The connection must be in place before the service is created or the service will need to be updated for the connection to appear in the existing resource. If the service is in place, restarting the service will add the connection.*

Hover text can also be applied to these nodes/ports links. If defined, the customize text is seen in the node’s tooltip when the mouse is paused over the node in zoomed in/outmode.

**Applying Topology Changes in Bulk (To Multiple Topologies at Once)**

There are times when an administrator will want to apply change across the board to all of the topologies within the system. CodeMettle has added a Bulk feature that enables changing aspects of a topology and applying that change to all of the topologies within the system.

In the Editor, select the **Bulk** tab in the left pane.
The left pane is split into the following areas, in order: Topologies, Nodes, and Links. Each of these areas can be modified and any changes will be applied to other topologies in the NMS system.

Note: to edit a specific topology but to have all changes applied across that network, select a topology from the upper set in the left column (the Topologies set, as seen below). The line type, whether the topology is to become primary, and whether the links are direct can be applied as well.

If the topology contains nodes that are links to other topologies, the node can be set to open directly in the rack view. (To configure this, edit the parent topology.)

Select the node that links to the other topology within the diagram. In this example, the node accesses the TKA network.
Select the node’s Click Class options in the left pane.

Select **Rack View Form**.

When the node is selected, the network will be seen in the rack view instead of the topology form. The rack view form is the same view seen by selecting the flip icon in the upper right corner of the topology display.

To save any changes, select the **File** menu and click **Publish Diagram**.

**Creating a Topology**

*Note: Node options described in this section, such as data point nodes, can also be applied when editing a topology.*

1. Click the **Standard** tab in the left pane.
2. Click the **File**→**New** option in the menu to open the blank drawing canvas. (This will be necessary if other topologies have already been viewed in the Editor.)
3. If needed, select the **Untitled** tab in the right pane.

4. Enter the diagram’s name in the **Name** field of the **Properties** area.
5. The Name entered in Properties is immediately propagated to the tab heading in the diagram. The * after the name indicates the topology has not been saved.
6. A map can be set as the background to the topology by selecting the desired geographic entity from the list.

7. Set the size of the map within the overall diagram by adjusting the **Map Size**.

8. To add a node to the diagram, select the element from the Palette and drag it to the desired spot in the diagram or set the node based on Latitude and Longitude settings to precisely set the node. This requires adding the Latitude and Longitude properties.
   a. With the node selected (and its properties seen in the left pane) click the + next to Properties.
   b. Enter LAT in the key.
   c. Click Enter.
   d. Enter the latitude coordinates.
   e. Click Enter.
   f. Click + again to add another property row.
   g. Enter LON in the key.
   h. Click Enter.
   i. Add the longitude value.
   j. Click Enter.
   k. The node will be added to those coordinates.
9. Click the **Node** tab.

10. Enter the name of the node directly within the shape or in the Properties **Name**. If the value is entered in the **Name** Properties field, click Enter to save the value.

11. If needed, select the Shape Type from the Properties. The assigned shape will be rendered when the shape is published and viewed within the **Views** area.

12. Increase or decrease the relative size of the object by selecting one of the corners and moving it outward or inward. For example, if this is a manned site, the size will be larger than the one used for a remote location.

13. Select the resource the shape represents within the Referenced Object list.

14. Select the Click Class (the form that will appear when the node is selected within the NMS GUI). If the node represents another topology, select the Topology form or the Rack View Form if the flipped/rack view is desired.

15. The height and width of the node in the service view can also be stipulated.
16. Repeat this action until all of the desired nodes have been placed in the diagram.
17. Node ports can be defined so any links can be assigned to a specific input or output. With the node selected, click the Ports tab.
18. Select the arrow next to the relative points on the node or the Static Connections option.
19. Click the green + symbol.
20. Click the **Enter Port Value**.

![Diagram showing ports and properties tabs]

21. Enter the string that will identify this port on the node. Multiple ports can be defined. This will create multiple ports on the side.
22. To edit a port, select the port and click the pencil (Edit) icon.

![Diagram showing port editing]

23. When defining a port, it may be preferable to select from a list of translators associated with that node, instead of a specific location. The NMS enables the user to add a list of “possible” values into a data point, which can then be selected as a port name.
24. Select the magnifying glass to view other datapoints and possible values.
25. Choose a Datapoint and see any possible values that have been defined as a possible port.

![Port Possible Values]

26. If changes are made, click **OK** to save the edits in the Port Possible Values and again in the Edit Port pane.

27. To create Static Connections, expand the interface. In this option, the connection’s Source and Destination are defined. Click the + icon.

![Static Connections]

28. In order to be included, the port must already be defined. Select the Source and the Destination points from the drop down lists.
29. To add links, select a node and draw a line originating from one of the highlighted points around the selection.

30. When connecting the line, the ending node will become selected. Connect the line to a highlighted point of the ending node by clicking the arrow on the desired side.

31. The line becomes a link.

   *Note: The end point must be selected by clicking (which will transform the line into a link) to complete the action and allow further selections. Until the link is established, any movements of the mouse will continue to draw the line.*

32. The link’s properties are seen. The source and destination nodes are already defined based on how the link was created. The source and destination ports can be chosen from the drop down lists. These settings will determine how the link will be rendered when the topology is viewed.
Adding Data Point Nodes with String Values

Data points with string values can be added to the topology. In the Topology view, if a data point node with embedded instructions is selected, the send instruction form is seen.

1. In the Editor, add a node to the topology by dragging it into the topology.
2. A name does not need to be entered.
3. Select the Referenced Object. This must be a resource.
4. Set the Shape Type to be “Datapoint”.
5. Attach an instruction to the data point by selecting an option from the Datapoint Key list; this can be any instruction that involves a configurable setting, such as device URL, HPA Forward Power, etc.

The screen below gives an example of a data point node in the Editor. Although the name is the referenced object, within the diagram the node is labeled with the instruction (DeviceUrl).
6. If needed, re-shape the data point by dragging its sides until the text is rendered appropriately.
7. When the fields are completed, select **Publish Diagram** from the **File** menu.
8. A popup message appears stating the save/publish has been completed.

Data point nodes appear in the main NMS window as a text string displaying the current configuration.
To change the current setting within the Topology view, click the string to evoke the instruction form.

Values can be entered directly into the Instruction form. If the settings are changed, click **Send**. This sends an instruction to the server.

Selecting the Service Alarm data point will display an alarm circle that will change color to match the current severity level. This is highlighted below.

**Adding Links**

To reduce operator error, the Editor also allows adding links with a built-in tool. Using this tool, the user can fill in the link’s properties precisely instead of adding a link in freehand between nodes.

Select **Tools**→**Add Links** from the menu.
The Add Links window opens. In one window the link’s Source, Destination, display properties, and any mouse over properties can be entered.

If the currently viewed topology is new, the lower pane is empty as no links exist yet.

If the option was selected while an existing topology is loaded, the diagram’s current links are listed.
Selecting the **Source Node/Port:** and the **Destination Node/Port:** will list the entry points in the currently loaded topology.

Select the source and destination ports as well as any other desired properties. Click **Add Link.** The entry is immediately added to the list and will be seen in the topology.

*Remember, to save the changes, the topology will need to be published (File ➔ Publish Diagram).*

**Diagram Settings**

Click within the canvas and not on a specific object to access the diagram’s overall settings. These settings are applied to the entire diagram.
1. This diagram has not been named, so the Name value is currently Untitled.
2. There are two link types: Direct and Orthogonal.
3. The Min Segment Length creates a connection link from the main circuit to the node. This helps highlight where there is a connection point within the network.
4. The example below is of a Direct Link Style with the Min Segment Length of 10.

Diagram Layout
The Editor provides layout icons in the toolbar. These can be applied when multiple nodes are selected. To select more than one node, hold the command key (on a Mac) or a Ctrl key (on a PC) while selecting the objects.

Use the following icons to line the selected objects as needed. The alignment will be set to the farthest relevant point among the selected nodes. In other words, the nodes are aligned in relation to each other, and not in relation to the overall size of the canvas or other nodes that may be present.

Note that certain combinations (multiple alignments) may cause the nodes to be layered on top of each other, appearing to become one. If this occurs, click outside of the nodes to deselect the group and then drag each node out to separate each instance from the others.

- The selected nodes will be aligned to the left
- The selected nodes will be aligned to vertical center (one above another)
- The selected nodes will be aligned to the right
- The selected nodes will be aligned at the top
- The selected nodes are aligned to horizontal center (one to the left or right of another)
- The selected nodes are aligned at the bottom

Diagram Layering
The Editor also supports layering. This allows nodes to be placed in front or behind each other to provide a dimensional aspect. To apply layering, select a node among the group to move it back and forward.

- This brings the selected node all the way forward (to the top layer)
- This brings the selected node one layer up (forward or to the top layer)
- This brings the selected node one layer back (toward the bottom or behind other layers)
- This brings the selected node all way backward (to the bottom layer, behind all the others)
Diagram Navigation
Whether in the Palette or the Topology area, CodeMettle provides icon shortcuts to manipulate the view of the diagram.

- ![Zoom In](image.png) This zooms the diagram to fit into the current canvas display
- ![Zoom Out](image.png) This zooms the view in closer (image becomes smaller and less of the whole may be visible)
- ![Zoom Out](image.png) This zooms the view out (image becomes smaller)

Publishing the Topology
1. Select **File → Publish Diagram** from the menu.
2. If the **Topologies** tab is selected now, the new diagram is seen within the list. The diagram is also added to the Topology section of the **Views** dropdown menu.

Creating Templates
To create a template, click the **Use as template** option in the main pane. Templates are used to create additional topologies based on this diagram. Setting the topology as a template means the template will only appear within the system if there is resource group associated with it.

When the **Use as template** option is selected, an additional property is added called **Groups for Template (comma delimited)**. To complete setting the topology as a template, enter one or more Resource Groups names here. A template can be used for multiple resource groups.
Enter the group names, separated by commas, to associate them to this template. When the cursor is moved to another field, the groups are added as a Properties Key.

Templates are created just like other topologies. When a node is added, there is another extra field in the Node details: the Template Reference ID.
This field accepts the Template Ref IDs set up in the individual resource’s properties. Each node on a topology template needs to include a unique Template Reference ID. This is a string key that should match the Template Ref IDs set up in the properties of a resource that is in the resource group being used to render the topology.

When the data is added to the topology template, it becomes part of the node’s Properties. Only one value can be added to this field.
Click File -- Publish Diagram to save the template. The entry is NOT included in the Topologies list under Views, but can be opened and edited within the Topology editor in the Topology area.

Importing and Exporting Diagrams

In addition to creating new topologies, administrators can import other files, including Visio drawings. If multiple files are imported, the first one in the group will be designated the Primary topology by default. A completion message is displayed to indicate the import was successful.
Diagrams created by the Editor can be exported to other NMS users. Exported diagrams are in CodeMettle’s proprietary file type and can only be viewed within an NMS environment. These actions are initiated from the Files menu in the Editor interface.
Opening Tickets

If configured, CodeMettle enables the operator to access the site’s NOC/trouble ticketing system directly without actually leaving the NMS interface.

1. Select **Open Ticket** from the user drop down list.
2. A pop up window appears.
3. Enter the Username and Password used to access the NMS. The system has been designed to allow the same username and password to grant access to the ticketing system. Using the NMS user profile associates the NMS user as the individual reporting the ticket.
4. Select the ticketing Server from the drop down.
5. Click **Next**.
6. Select the Project for the ticket.
7. Click **Next**.

8. Select the component for the ticket.
9. Click **Next**.
10. Enter the Summary and Description for the ticket.
11. Click **Create**.

The ticket is added to the local ticketing server/application.
Viewing Logs

Every NMS module has its own associated log file. Log files are used for deeper views into how each module is operating and how it interacts with other modules and resources. Logs serve as a means of debugging translators. This chapter explains how to set up the log’s output to get the desired information and how to configure the resource or transport to send debugging entries to the log.

The CAM log is where administrators will find detailed information on what a resource or transport is sending and receiving. The CAM log file is located under the /usr/local/SherpaServer/logs directory and is called cam.log.

The best way to peer into a log is applying `tail` on the file. The `tail` command shows the most recent entries first.

Access the folder using `cd` (change directory) and then type `tail -f cam.log` (as shown below).

Below is sample output.
Once tail is running on cam.log, the administrator’s next step is to configure the resource to write to the log. To do this, go to the NMS UI, select the node, and then select the full console icon.

As shown below, click on the button circled in red to send a command for the ‘The current logging level’ datapoint. Set the value to DEBUG from the drop down list and send the command.

The cam.log will now commence outputting debug information for the resource. The sample output is below.
### 6.3.7

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECV</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
<tr>
<td>LISTEN</td>
<td>NMSG</td>
<td>TYPE: 0000 with status: 0000 and data len: 102</td>
</tr>
</tbody>
</table>

© 2012-2014 Code Mettle
Definition of Terms and Acronyms

Not much is more frustrating than seeing an acronym or term and not getting an explanation of what it’s supposed to represent. This chapter is meant to avoid that frustration. If you find a term or acronym in this manual that you think should be added to the list, please let us know.

Items are organized alphabetically.

**Ack**

Ack is short for acknowledge. When an alarm is acknowledged, it means that the event is being investigated by someone and can be ignored, even though the alarm has not been cleared.

**CAM: Correlation and Automation Machine**

The CAM is the core data acquisition, automation, and correlation module of the NMS. The CAM acquires and normalizes data, performs correlation and pattern detection, and enables automated actions to be taken based on the results of its analysis. The CAM can be replicated as many times as necessary to accommodate very large systems spanning vast geographical expanses.

**Data point**

The measurements contained in a data point can specify whether the measurement results in a Boolean value (yes, no), an integer or real number (1, 2, 3) the identity of a category, or an array. A point implies it can be plotted in a graphic display. Ultimately, a data point represents a value that can definitively represent a normal or abnormal status; and thus trigger no alarm, minor alarm, or major alarm.

**ESB—Enterprise Service Bus**

An enterprise service bus (ESB) is a software architecture model. The motivation behind the ESB was to find a standard, structured and general-purpose concept around loosely coupled software components (i.e. services) that are be independently deployed and run within a network. ESB is also the intrinsically adopted network design of the World Wide Web and the common implementation pattern for Service Oriented Architecture designs.

**KPI—Key Performance Indicator**

KPIs are commonly used to evaluate success. In the context of the NMS, the KPI is a measurement with defined norms that are achievable, relevant, and be represented over time. Examples are the graphs generated from repeated polling results.

**MRP—Managed Router Port**

A Managed Router Port is a managed switch that directs data traffic from a specified input, which is configured to receive data from a resource/port, to a specified output, also configured to a specified resource and port.

**Mask**

Masking determines whether the alarm is displayed on the alarm grid. It does not affect the alarm’s status or behavior. For example, you may choose to mask an alarm if you know a resource will be offline.

**Multi Service Resource (MSR)**

A multi service resource is a resource that provides more than one service within the network. Consequently, this resource’s status can impact multiple functions. Designating the resource as a multi service resource allows the administration of the resource and all of its services as a single entity and prevents duplication of actions and alarms.
Resource
A resource is any physical or virtual component within the system. Resources include the means for input, processing, output, communication, and storage. Resources, combined with the means to transport processed data, can produce services.

Service
While service applies to many industries and contexts, in this one it represents the fulfillment of a requirement (task, function) involving multiple resources and their combined data and efforts. Thus, a service includes the resources, the data paths, and the instructions needed to massage and present the data needed by the next resource group/service in the workflow. Further, services are unassociated, loosely coupled units of functionality that have no embedded calls to each other. Each service represents one action.

Service Affecting Alarm
Taking the above a step further, a service affecting alarm indicates that the issue does not only affect an individual, but the service (and function completion) that resource is part of. Usually a service affecting alarm indicates a major, severe issue that calls for quicker attention than alarms that are not service affecting.

SOA—Service Oriented Architecture
SOA is a set of methods to develop service software. These services are defined functions built on software components (pieces of code or data structures) that can be used repeatedly. SOA developers associate individual SOA objects (that have no calls or connection to one another) by associating each service’s functionality in a non-hierarchical arrangement.

Topology
The topology is the arrangement of the network elements (nodes, links, etc.). In any network, every node or resource has one or more links to other devices. Graphically mapping these links results in a shape that can be used to describe the network’s physical topology. Logical topologies illustrate how data flows within the network, and have no relation to the physical design.